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Introduction to EMC Testing

EMI regulations are in place throughout the world to provide
improved reliability and safety for users of electrical and
electronic equipment. If you are developing a product emitting
or susceptible to electro-magnetic interference, you are
required to certify your products for EMI compliance. If you’ve
taken a product through EMI certification, you know a great
deal of time and effort goes into the design of a product to
minimize the EMI signatures and the impact from failing EMC
certification.

To ensure compliance with regulations, many companies have
historically employed the services of a specialized test facility,
or test house, to perform EMC pre-compliance and compliance
testing. Unfortunately, using third party test houses can add
significant product development costs and time to a project.
As a result, companies are looking for and investing in easy-
to-use, affordable pre-compliance testing solutions they can
utilize in their workspace.

Comprehending compliance requirements, incorporating pre-
compliance testing into the design and prototyping stages, and
performing pre-compliance testing in-house can identify and
address potential EMI issues before a product is submitted for
compliance testing. Testing in your own lab gives you the time
to methodically isolate your problem areas and apply different
corrections, saving time and money.

This application note provides an overview of EMI testing,
information on test set-up, setting up a measurement,
configuring accessories to increase measurement accuracy,
how to perform measurements and troubleshooting tools to
accelerate debugging. This application note provides a step-
by-step guide for performing pre-compliance testing using
Tektronix Real-Time Spectrum Analyzers and SignalVu-PC with
EMCVu software. Please note that while EMC testing requires
both emission and susceptibility testing, this application note
focuses on emission testing. Using these techniques can
reduce the risk of your product failing final full compliance
testing at the test house.

APPLICATION NOTE

COMPLIANCE TESTING

Compliance testing requires methods, equipment and
measurement sites in compliance with national or international
standards. Testing is required to confirm that a device meets
the required standards. It divides broadly into emissions
testing and susceptibility testing. Compliance with national

or international standards is defined by individual nations. It’s
important to note, different nations can require compliance
with different standards.

Open-air test sites, or OATS, are the reference sites in most
standards. They are especially useful for emissions testing of
large equipment systems. However, RF testing of a physical
prototype is more often carried out indoors, in a specialized
EMC test chamber. Types of chambers include anechoic,
reverberation and the gigahertz transverse electromagnetic cell

(GTEM cell).

\L n i e
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FIGURE 1. Example of an EMC test chamber (Image courtesy of Microwave
Vision Group
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Compliance tests are commonly done prior to production of a
device. Compliance testing can be exhaustive, time consuming
and expensive. A failure in EMC compliance at this stage of
product development can result in expensive re-designs and
product introduction delays. Testing for EMC compliance
includes both radiated and emissions tests.

The term Radiated Emissions refers to both the intentional
and unintentional release of electromagnetic energy from an
electronic device. To make sure a device is operating safely,

a radiated test is performed to ensure emissions emanating
from the Device Under Test (DUT) or the Equipment Under Test
(EUT) comply with the applicable limits.

The term Conducted Emission refers to the mechanism that
enables electromagnetic energy to be created in an electronic
device and coupled to its power cord. Like radiated emissions,
the allowable conducted emissions from electronic devices are
controlled by different regulatory agencies.

The full compliance test in a certificated lab can be expensive
with costs ranging from $1,000 to greater than $20,000 per
submission depending on the device and the number of
countries you are selling your product into. Full compliance
testing can also be time consuming with emissions and
immunity testing taking 2 to 6 days and generation of the test
report taking another 3 to 10 days. Note, this doesn’t include
the time to get your product into the test queue.

To prepare for compliance testing, many companies have
historically, rented time in full compliance test facilities. This
too can be expensive with costs ranging from $700 for a half
day to $10,000 per day depending on the services needed.
As an alternative, some companies have chosen to set up
fully compliant test facilities in-house. The benefit of this is
testing in an environment that duplicates actual testing. The
disadvantage is costs can range from 100s of thousands to
millions of dollars.

4 | WWW.TEK.COM
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PRE-COMPLIANCE TESTING

An affordable and convenient alternative to using fully
accredited compliance labs is investing in a pre-compliance
test solution. Pre-compliance testing offers a fast, affordable
method for evaluating your design and any modifications made
as you go through the design process. At the early stages of
development, design-for-EMC techniques are combined with
diagnostics to produce low compliance signatures and low
susceptibility to both external and internal interference. Later in
the development cycle, pre-compliance testing may be used to
catch compliance problems early and improve the probability
of a successful first pass of full EMC compliance testing
without additional re-design.

The goal of pre-compliance testing is to mimic the compliance
test set up within an acceptable margin to uncover potential
problems and reduce risk of failure prior to the expensive
compliance test stage. Pre-compliance testing does not
require compliant test equipment and typically involves:

e Spectrum analyzer with quasi-peak detector
e Preamplifier (optional)
e Antenna with non-metallic stand for radiated emissions

e Line impedance stabilization network (LISN) for
conducted test

e Power limiter for conducted test
e Near field probes for diagnostics (optional)
e Oscilloscope with frequency & time correlation capabilities

to assist in debugging (optional)

Pre-compliance testing may be done using fast measurement
techniques intended to give a ‘quick look’ at problem areas
and is typically done at a temporary site by engineering
personnel.
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When selecting a test site, it is best to pick a location that

will minimize external signal sources. Rural areas, conference
rooms or basements are good because they minimize signals
that might mask the DUT emission levels you are trying

to measure (Figure 2). Other considerations for improving
accuracy involve having a good ground plane and reducing the
number of reflective objects around the test area.

General-purpose spectrum analyzers, such as the Tektronix
RSA300, 500 and 600 series offer general purpose filters and
detectors that are employed in pre-compliance testing and
troubleshooting any EMI issues.

Tektronix offers a full line of Real-time Spectrum Analyzers,
oscilloscopes and validated accessories including antennas,
Line Impedance Stabilization Networks and pre-amplifiers
individually, or in two comprehensive accessory bundles for
conducted and radiated tests. Additional information on these
accessories are located in the Appendix section.

Test Setup

We start with an introduction to Radiated and Conducted
Emission tests and a description of the setup to conduct pre-
compliance testing. This section also includes information on
Resolution Bandwidth (RBW) and Detection Methods.

RADIATED TESTS

The setup for radiated Compliance tests is specified in the
applicable Standard document. You should refer to these

standards when setting up radiated testing, attempting to
mimic the testing as close as possible.

APPLICATION NOTE

In setting up Radiated testing, there are several challenges you
should be aware of. The first is electromagnetic waves don't
extend out from your product in a nice spherical pattern. The
emissions tend to be directional. To address this, a test lab
will typically vary the height of the receiving antenna between
1 and 4 meters, as well as rotate the EUT on a turntable. The
receiving antenna picks up both the signal direct from the
EUT, as well as a bounce off the ground. The second is, to
increase measurement accuracy, the ground is covered with
an electromagnetically reflective surface (aluminum, steel, wire
mesh etc.) to create a ground plane. For accuracy, the ground
plane area should be relatively flat. The EUT is scanned in the
frequency band of interest and you will look for emissions that
are close to the limits.

A Radiated Emission Pre-Compliance test setup includes your
EUT, Ground plane, Antenna mounted on a tripod, a pre-
amplifier and a Spectrum analyzer (Figure 2). The radiation
from the EUT is picked by the Antenna, with the output
amplified by a pre-Amplifier for better sensitivity. The output
of the pre-Ampilifier is connected to the input of the Spectrum
analyzer to acquire the signal and analyze it with the help of
the software (EMCVu).

Antenna

Isolated / \
Tripod /
/

/
/

FIGURE 2. This diagram illustrates the set-up for Radiated testing with Antennas,
Pre-Amplifiers and cables.
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CONDUCTED TESTS

Conducted Emission tests are about testing that portion

of electromagnetic energy created by your device that is
conducted onto the power supply cord. The goal is to restrict
the amount of interference your device can couple back onto
a power supply. Test labs measure these emissions (usually
from 150 kHz - 30 MHz) and verify that the EUT complies with
specified limits.

This helps to ensure that the local power supply remains
relatively 'clean' and nearby devices won't be affected by your
device. Conducted emissions testing is usually performed

on devices that connect to an AC power supply. For some
standards, there are also limits placed on devices that operate
from a DC power supply.

main

RSA306B

FIGURE 3. Conducted emissions test setup.
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LISN (LINE IMPEDANCE STABILIZATION NETWORK)

For conducted measurement instead of antennas you use a
LISN (line impedance stabilization network). A LISN3 is a low-
pass filter which is placed between an ac or dc power source
and the DUT to create a known impedance and to provide an
RF noise measurement port. It also isolates the unwanted RF
signals from the power source. Again, adding a pre-amplifier
is a good way to boost the relative DUT signal levels. Figure 3
shows a block diagram of our setup.

Caution! It is critical that the spectrum analyzer input is
disconnected from the LISN prior to unplugging the source
power to the LISN! The discharge levels from the LISN can
damage the front end of the spectrum analyzer.

Note that the interference being conducted on a 60 or 50 Hz
power supply can be an issue for some. While most of the
conducted EMI tests specify a measured frequency range
of 9 kHz to 1 GHz, it can be useful to measure the signals at
lower frequencies when the need arises. For low frequency
measurements, the Tektronix RSA5100 Series real time
spectrum analyzer is a good choiceas it covers frequencies
down to the sub-hertz frequency ranges.

For best conducted EMI measurements, it is advisable to use
2 LISN’s: one for a defined impedance to the DUT, and the
second to go to the spectrum analyzer or receiver.
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MARKET
SEGMENTS

EQUIPMENT TYPE

STANDARDS

IEC/CISPR

APPLICATION NOTE

CENELEC/EN | FCC MIL-STD | DEF-STAN

ISM Industrial, scientific and medical equipment CISPR 11
EN 55011 CFR Title 47 Part 18

MEDICAL Medical electrical apparatus EN 60601-1-2

Vehicles, boats and internal combustion engines CISPR 12 EN 55012 CFR Title 47 Part 15()
AUTOMOTIVE

Components and modules on board vehicles CISPR 25 EN 55025

Sound and TV broadcast receivers CISPR 13 EN 55013

Information technology and telecommunications CISPR 22 (superseded :Esﬁs;gige d
MULTIMEDIA equipment (ITE) by EN55032) by EN55032) CFR Title 47 Part 15

. L - . CISPR 32 (replaces

Professional audio/video/multimedia equipment CISPR 13 and 22) EN 55032
APPLIANCES Electrical devices, household appliances and tools | CISPR 14-1 EN 55014-1 CFRTitle 47 Part 15
LUMINAIRES Fluorescent lamps and luminaires CISPR 15 EN 55015 CFRTitle 47 Part 15
MILITARY Military equipment and systems 4Mg%'GSTD' ggiﬂAN

TABLE 1. Regulatory Standards.

REGULATIONS AND REGULATORY AGENCIES

Many commercial EMI measurements requirements are
defined by the Comité International Spécial des Perturbations
Radioélectriques (CISPR), a technical organization within

the International Electrotechnical Commission (IEC), an
international standards body. Other standards and certification
bodies, such as TELEC in Japan, also have requirements for
measurement methods and certification techniques. In the
US, the Department of Defense has developed the MIL-STD
461G with special requirements for military equipment. Table
1 lists some of the standards as they relate to different market
segments.

Operation in countries within defined regulatory domains may
be subject to additional regulations. Companies developing
products requiring Compliance certification should refer to the
country regulatory sources for further information on specific
products and country requirements. Table 2 lists some of the
current regulatory bodies and the countries in which they have
jurisdiction.

COUNTRY APPROVED REGULATORY BODIES

United States | Federal Communications Commission (FCC)

Canada Industry Canada (IC)

Europe International Electrotechnical Commission (EN/IEC)
Japan Ministry of Internal Affairs and Communications (MIC)
China Ministry of Industry and Information Technology (MIIT)

TABLE 2. Examples of regulatory bodies.
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EMC MEASUREMENT PARAMETERS

Resolution Bandwidth (RBW)

The bandwidth of the measurement is defined by a receiver

bandwidth shape or a resolution bandwidth (RBW) filter in

the case of a spectrum analyzer. The bandwidths used are

representative of the perceived threats within the spectrum,

and the bandwidths vary with the receive frequency. The

level measured by a receiver or spectrum analyzer of any

non-continuous signal will depend upon the measurement

bandwidth used. To achieve consistent results, regulatory

agencies have defined the bandwidth and shape of the filters

used in compliance measurements. Filter bandwidths specified

by CISPR for peak, RMS, and average detectors are shown
in Table 3. The American National Standards Institute (ANSI)
and MIL-STD-461 bandwidths are shown in Tables 4 and 5,

respectively.

FREQUENCY RANGE BANDWIDTH (6 DB) REFERENCE BW

9 kHz to 150 kHz 100 Hz to 300 Hz 200 Hz
(Band A)

0.15 MHz to 30 MHz 8 kHz to 10 kHz 9 kHz
(Band B)

30 MHz to 1000 MHz | 100 kHz to 500 kHz 120 kHz
(Bands C and D)

1 GHz to 18 GHz 300 kHz to 2 MHz 1 MHz
(Band E)

TABLE 3. Measurement Bandwidth versus Frequency specified by CISPR 16-1-1.

FREQUENCY RANGE BANDWIDTH (6 DB)

10 Hz-20 kHz 10, 100, and 1000 Hz
10-150 kHz 1 and 10 kHz

150 kHz-30 MHz 1 and 10 kHz

30 MHz-1 GHz 10 and 100 kHz

1-40 GHz 0.1,1.0 and 10 MHz

TABLE 4. Bandwidths versus frequency specified for peak, average and RMS

detectors by ANSI C63.2.

30 Hz — 1 kHz 10 Hz

1 kHz-10 kHz 100 Hz
10 kHz-150 kHz 1 kHz
150 kHz-30 MHz 10 kHz
30 MH-1 GHz 100 kHz
Above 1 GHz 1 MHz

TABLE 5. Bandwidths versus Frequency specified by Mil-STD-461E.
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DETECTION METHODS

A detector calculates a single point that represents the signal
over a defined sampling interval. Detection methods can
calculate the positive or negative peak, the RMS or average
value of voltage, or the Quasi-Peak (QP) value. The compliance
labs use quasi-peak (QP) detectors for the full compliance test.
The EMI department or the external labs typically begin their
testing by performing a scan using simple peak detectors to
find problem areas that exceed or are close to the specified
limits. For signals that approach or exceed the limits, they
perform QP measurements. The QP detector is a special
detection method defined by CISPR 16-1-1 standards. The
QP detector serves to detect the weighted peak value (quasi-
peak) of the envelope of a signal. It weights signals depending
upon their duration and repetition rate. Signals that occur more
frequently or last longer will result in a higher QP measurement
than infrequent, short impulses.

An example of peak and QP detection is seen in Figure 4.

Here, a signal with an 8 ps pulse width and 10 ms repetition
rate is seen in both peak and QP detection. The resultant

QP value is 10.1 dB lower than the peak value. A good rule

to remember is QP will always be less than or equal to peak
detect, never larger. Tektronix SignalVu-PC with EMCVu
software offers average and quasi peak detection to do your
EMI troubleshooting and diagnostics. You can use the same
approach used by the lab and start with a fast peak scan of the
device to verify you find the same issues the lab reported. Then
you can implement fixes and validate fixes with a localized
quasi-peak detection.

© 30,00 m
© afd:
10068

o Rew:
204

Quasi-Peak Response

130,00

> G 10000M

FIGURE 4. Quasi-peak and Peak measurements.
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Setting Up a Measurement

Now let’s walk through how to do Pre-compliance testing of
your equipment with the Tektronix SignalVu-PC and EMCVu
software.

The software provides four key features to perform Pre-
compliance -

e Setup Wizard
e Measure Ambient

e Re-measure spot
e Report
SETUP WIZARD

Select Setup > EMC > Setup Wizard Or click on Setup Wizard
in EMC Toolbar.

Setup Wizard leads the user through a series of well-defined
steps to complete the test setup to perform a EMC pre-
compliance test.

Emisson Type: O Conducted @© Radated

Getting Started | Accessories | Ranges & Limits [ Reports|
Thank you for choosing to do EMC pre-complance with Tektronix. Folow these steps to set up and run a test.

Step 1 Set Emsson Type (ether Conducted or Radiated). (Look above the tabs for Emission Type)
Step 2 Select the Accessones tab to ndude Accessones and ther Gans/Losses/Factors.

Step 3 Select Ranges Limts tab to load standard recommended frequency ranges and imt ines.
Choose a method of measurement (e.qg. to accelerate CISPR Quasi peak measurements).

Step 4  Select the Reports tab to provide EUT nformation to be nduded n reports.

Step 5 Cick on Setup Complete - Run Test to ntiate a sngle scan (at the bottom right comer) or press Scan in the EMCVu
toobar (below Tektronix logo in the top nght).

Note - Reference Level (Ref Lev) can be changed for better senstivity in the Basic Toobar (at the bottom above status bar)
Press the Help button in each tab (at the bottom left comer of the wizard) for spedfic usage detais.
Use EMC toobar to

a) Bring back Setup Weard, b) Measure Ambient c) Re-measure Spot frequences and d) Generate Reports

&) Actvate troubleshooting tools (Harmonic markers, Inspect, Level Target, Compare Traces and Persistence Dsplay)

Fnd more n-depth nformation about these tools, Select Help > User Manual from the Man menu bar.

Save Project Setup

Recal Poject Setup |

FIGURE 5. EMC Project Setup Wizard.

APPLICATION NOTE

Tabs to set up your test
e Getting Started: Gives you a quick idea of the steps to be
followed.

e Accessories: Lets you set the contribution of all the
accessories used.

e Ranges & Limits: Lets you specify the ranges of the test
and limits for comparison. Standard recommended values
can be loaded too. Choose measurement modes.

e Reports: Lets you specify the details to be included in the
report.

Other important selections

e Emission Type: Choose between Conducted or Radiated
emission.

e Setup Complete- Run Test: Hit the button when the setup is
complete to initiate a Scan.

e Save Project Setup: Saves the entire settings in the wizard
as EMC Project Setup.

Recall Project Setup: Recalls the entire settings saved
earlier as EMC Project using Save Project Setup.

Detailed information about Adding Accessories, Ranges &
Limits and Reports tab are as follows.

WWWTEK.COM | 9
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Adding Accessories

The Accessories setup allows you to include the contribution
of the accessories used in the test. The final measurement
reading is corrected based on these accessory contributions
before it is shown in the display. The correction is calculated
by negating the Combined Impact of all the accessories Gains/
Losses entered by you.

Each of these accessories have their own Gain/Loss (Antenna
factor in case of Antennas) that must be accounted for to get
an accurate emission measurement. The measured reading
must be corrected for the Gain/Loss/ Factor contribution due
to these accessories.

The EMCVu software allows you to correct for the accessory
contributions. You can either use the Setup Wizard —
Accessories tab or the Accessories tab in the Settings control
panel to account for these contributions. You can view the
Combined Impact of all the accessories in a graph too.

The typical values of Gains/Losses/Factors of each of the
Tektronix provided accessories is available for you to easy
load. You can either use the “Load Tektronix provided
Accessories Gains/Losses” from the Setup Wizard or you can
load individual accessory files using “Configure Accessories
> Edit > Load”. The individual csv files are available at C:\
SignalVu-PCFiles\EMC Accessories.

ACCESSORY SELECTIONS

The accessories selection depends on the emission type
selected.

EMISSION TYPE AVAILABLE ACCESSORIES SELECTION

Conducted LISN, Cable, Limiter, Amplifier, Attenuator, Filter
and Others

Radiated Antenna, Near field probe, Cable, Amplifier,
Limiter, Attenuator, Filter and Others.

A maximum of six accessories can be included in the test
setup as shown above.

10 | WWW.TEK.COM
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EMCSettngs  [paameters|[Emission Type | Accessories [ Ranges & Limits | Measurement Type| [ Traces|[Ambient|[Scale [ Prefs|
@ (usn O (o] O Frer O [eee] [ vewpot
@ Cadle [ [est] [ others o [ese] [ Load Al Accessones |
[ meer ™ E\ [ Others > E\ lm

Restore
Defauks

FIGURE 6. Accessories can be selected using the drop down provided.

SETTING
View Plot

| DESCRIPTION

Gain/Loss plot can be viewed by clicking on
View plot. Sample snapshot shown below. This
will also show the Combined Gain/Loss as a net
impact of all the accessories. Find more details
below in the section Combined Gain/Loss.

Save all Accessories Complete Accessories setup can be saved in a
file for reuse. Clicking on this button will save

details about all the accessories.

Load all Accessories Complete Accessories setup can be Loaded
from the saved file. Saves time as compared to

loading them one by one.

EDIT ACCESSORY CONTRIBUTION

Accessories specific information and details like Model no,
Serial no, Asset tag, calibration due date can be edited using
Edit option. A window such as the one shown below will open.
A sample snapshot is shown for Amplifier and Antenna (Factor
and isotropic gain).

 cic Ampi B
Modet [PANLOS ] Select Gan/Loss Format Ampifier Gain/Loss (Gain > 0, Loss < 0)
Serat O Constant Gain/Loss Freq (H) _ ~ Gan/loss(d8) ~ Add
) [ 300.000M 35.32441
3 @ Amplifier Gain/Loss Table
s ] 2 325.000M 35.25395 Delet
Cal Due Date: 05/28/2017 3 350.000M 35.12368 [oskte AtRovs]
) Disable Cal Due Date 4 375.000M 34.9303¢
5 400.000M 34.80666
6 425.000M 34.68036
Frequency Interpoiation 7 450.000M 34.49289
© near 8 475.000M 34.75072
Otog ° 500.000M 3474375
Save As oK Gancel

Modek: Select Gan/Loss Format. Antenna Factor
et [ ] O constant Gan/Loss Freq () = Facor (/m)_ A][ adg
1 300.000M 13.16621255 -
N na Gain/Loss Table
(3 2 350.000M anomsesons | |0kt
Cal Due Date: 05/28/201 3 400.000M 14.86559991 Delete Al Rows
() Disable Cal Due Date 4 450.000M 16.69212514
5 500.000M 17.41470004
6 550.000M 18.34362689
Frequency Interpolation 1
. T 7 600.000M 19.7365125
@ Lnear 8 650.000M 19.54413357
Ol 9 700.000M 20.1250804 o
“Load_|| [[savens Gancel

FIGURE 7. Overall impact of accessories gains/losses.
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Modek: [ABF00
Serat

Asset Tag:
Cal Due Date: 1
[ Disable Cal Due Date

Dstance: |10 m

APPLICATION NOTE

LOADING TEK SUPPORTED ACCESSORIES FROM A FILE

Select Gan/Loss Format

Antenna Gan/Loss (Gan > 0, Loss < 0)
Freq (Hz)  ~  Gan/Loss (dB) A Add

1262169983

30.000M -12.15827491

O Constant Gain/Loss
»

Tektronix supports some of accessories namely Antenna,

@ Antenna Gan/Loss Table Delete |

Delete Al Rows

1
N 2

N 3 35.000M 1063933911
4 40.000M -8.369500173
5 45.000M 6136449724
5
7
8
9

Ampilifier, near field probe and LISN with their detailed

50.000M -5.141299913

information embedded in a .csv file which is readily available
Frequency Interpolation 55.000M -4.73344621

65.000M 4.852432867

® unear

for the user as a part of the software in the location SignalVu-

Oy

Load_|| [savess oK

[Loncel | PC Files\Example Files.

LOADING NON-TEK SUPPORTED ACCESSORIES FROM A FILE

Impact of Accessories Gains/Losses
Note: Amerve facir and Conbred n @Bjw)

Details of Non - Tek supported accessories can be loaded by
preparing a .csv file manually by the user. (You can also build it
using the Ul by adding a row for each frequency)

The Gain/Loss table values are usually found from the
datasheet or graphs and accessory supported documents
‘""'—-’;’!f’*-:;.-r;_;;_: provided by the vendor when purchased.

You can build a csv file with only two columns (Freq column
and Gain/Loss column) without headers and you can load the

) Show Ponts
Preq Scue
Lnear
wo

FIGURE 8. Add accessory specific information for each accessory.

file into this User interface through Load button. You can also
add more frequency rows by editing the csv fie. Once you load
such a csv file, you can enter the other details like Model, Serial
number etc. and save the file again and another csv file with all
additional details and with appropriate headers would get saved.

s w0 s om
Frequency (MHz)

SETTING

DESCRIPTION

Model Specify the Model Name/number of the accessory.

Serial Specify the Serial Number of the accessory.

Asset Tag Specify any user-specific Asset tag id for the accessory.

Cal Due Date Specify the Calibration due date of the accessory. It can be disabled by checking the checkbox if not required.
Distance Specify the Distance between EUT and Antenna (Applies only when accessory is antenna).

Select Gain/Loss
Format

Choose between the options available below. A) Constant Gain/Loss, B) Gain/Loss Table. For Antenna, you will have a third selection
available C) Antenna Factor

Constant Gain/Loss

Specify the loss value which is constant for the complete frequency range. The Gain/ Loss will be entered in dB. Gain values are
entered as positive dB value and Loss as negative.

Gain/Loss Table Specify the loss values at specific frequency points. The Gain/ Loss values in these tables will be entered in dB. Gain values are
entered as positive dB value and Loss as negative. The values in between the frequency points are interpolated with frequency axis
treated as Linear/Log based on the Frequency interpolation selection. Note- For Antenna, this table will be entered in dBi (isotropic
Gain values) as shown in the snapshot above.

Antenna Factor Applicable only for Antenna. Antenna factors are given in dB/m. These values are typically available in vendor data sheets. You can
also load the typical values from Example Files if you have purchases them from Tektronix.

Frequency Specifies the frequency interpolation method used for interpolating Gain/Loss values or Antenna factors. The frequency axis points

Interpolation are either taken as Linear or Log values based on this choice. Linear interpolation is followed but x axis values can be either in Log
or Linear as per this selection.

Load Click to load a saved Accessory details from a file. This will recall all parameters seen in this window.

Save As Click to save the Accessory details to a file. (All details shown above)

0K Click OK to give confirmation of the entered details.

Cancel Click Cancel to ignore the edit window and exit. This will discard any changes that you might have made before OK is pressed.

Note: Gain/Loss Table corresponds to the accessory selected.

WWWTEK.COM | 11
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COMBINED GAIN/LOSS AND VIEW PLOT

Non-Antenna accessories

Combined Gain/Loss is calculated by combining the individual
Gains/Losses of individual accessories. Except for Antenna,
all accessories Gains/Losses are in dB (Gain >0, Loss <0). So,
the combined Gain/Loss is arrived at by just adding all the
individual contributions. The plot shows the combined effect in
dB too in such cases.

This Combined Impact of Accessories Gains/Losses is negated
to arrive at the Correction factors and the correction factors
are applied to the actual spectrum analyzer reading before it is
shown in the respective displays.

Loss Table Plot LIz
Impact of Accessories Gains/Losses
@ Combined
- UsN

) S T e e S e S S S S .
- Cable
-
g ¢
H
z
-1
2
———g
-4
(2 Show Ponts
Freascale -
) Lnear (] 20 40 0 0 00 120 40
) Log Frequency (MHz)

FIGURE 9. Almpact on gain/loss is determined for the LISN and cable.

The Combined impact is calculated only for common
frequency range. If there are individual accessories that

have different frequency ranges, only the common range is
chosen for calculation of Combined Gain/Loss. An example
is shown below. The Combined loss range matches only that
of Near Field Probe although Cable and Amplifier’s Gain/Loss
information entered for a wider frequency range.
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APPLICATION NOTE

EMC Project Setup Wizard =
Emascn Type: O Conducted ® Radated
[Getting Started | Accessories | Ranges & Limits [ Reports|
Impact of Accessories Gains/Losses Configure Accessories.
@ Combined Load Tektronx proviced
- Near Field Probe Accessones Gans/Losses
A-Cable s
H Ampldier 30 &) Near Feld Probe (] h Ede
’ Cable Ee]
[ | Cabe ) [ eae
i 20
i 1 (2 |Ampifier ) | Ede
; 0 © |Cabe o (e
: O [Frer ) Ede
0 P
Others & | e
s ' @ .
’ 10 : [ Load A Accessones
2 Show Ponts ]
Freq Scale " | Save Al Accessones |
Unex ° 0 40 €00 00 0%
L9 Frequency (MHz)
Accessones Hep J Save Project Setup Recal Project Setup [ Setup Complate - Run Test

FIGURE 10. The combined impact is calculated only for the accessories common
frequency range.

It is this combined impact that is negated to arrive at correction
factors which is eventually applied to the measured trace
before it is shown in the displays.

Antenna

In case of Antenna, you can enter the accessory contribution
either as isotropic gain values or as Antenna factors (both of
which is commonly available in vendor data sheets). Isotropic
gain should be entered as any other accessory contribution
(Gain >0, Loss<0) and Antenna factors is expected to be entered
as you would see the factors in any data sheet in dB/m.

EMC Project Setup Wizard (]
Emssion Type: O Conducted ® Radated
[Getting Started | Accessonies | Ranges & Limits | Reports|
Impact of Accessories Gains/Losses Configure Accessories
@ Combined Load Teitroni provided
- Near Feld Probe b Accessones Gans/Losses
A * Ak
o Ampldier 0 [ Near Feld Probe ) } Edr
@ Cable -
@ | Gibe & (e
g e
E s (@ Ampifier (o [
s 10 @ Cbe =i
s [ Fre ) | Ede
° -
O Others ) | Ede
s ' e
) 0l - [ Load A1 Accessones
() Show Ponts ' J
Frea scale d [[save At Accessones |
Uner 0 0 0 €00 00 10%0
oo Frequency (MHz)
Accessones Hep J Save Project Setup Recal Project Setup [ Setup Complate - Run Test

FIGURE 11. For antennas enter either the isotropic gain or Antenna factor.
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Antenna factors are used to adjust the final reading as follows

Corrected Reading (dBuV/m) = Spectrum analyzer Reading
(dBuV) + Antenna Factor (dB/m)

So, when you have an Antenna as one of the accessory, the
results are also shown in Field strength units dBuV/m.

Note - the snapshot above has a note that says Antenna factor
and Combined Impact are in dB/m.

As mentioned earlier, the combined impact of all accessories
are negated to arrive at correction factors. However, as
Antenna factors are used as it is given in data sheet for
correction of results, Antenna factors are negated before
calculating Combined Impact of all Accessories Gains/Losses
in the above plot. That is the reason you would observe the
combined impact follows the inverse of Antenna factors in the
above figure.

The Combined Impact in the above case would be

Combined Impact (dB/m) = Amplifier Gain (dB) + Cable
effect (dB) — Antenna factor (dB/m)

(Please note Cable effect is entered as Gain >0 and Loss <0)

And the combined impact is eventually subtracted from the

Corrected Reading (dBuV/m) = Spectrum Analyzer reading
(dBuV) — Combined Impact (dB/m)

Even when the user enters the antenna contribution as
isotropic gain, they are converted to antenna factors before
presenting in the Combined Impact plot.

Antenna Factor (dB/m) = (20*log10(f (in MHz) — 29.7707) —
Isotropic Gain

Therefore, in the plot, you will always see the Antenna factor
contribution and the combined Impact is calculated as
explained above before it is finally negated to be employed as
Correction factors to the measured readings.

WARNING WHEN FREQUENCY RANGE OF SCAN DOESN'T
MATCH

A warning message is shown in the plot when the frequency
range of the Correction factors (-1*Combined Impact) is
smaller than the frequency range of the scan. When a scan
is attempted beyond the frequency range of the Correction
factors, the following warning message is shown

“Scan range exceeds range of Combined accessories.
Reduce scan range”

APPLICATION NOTE

Performing a Measurement
CHOOSE MEASUREMENT METHOD

Once the right Ranges & Limits are loaded, you can decide to
do the measurement in one of the three measurement methods
available.

Three measurement methods available are available for most
standards

e Pre-scan + Manual Spot - A quick pre-scan followed by
choosing spots from results table and re-measuring them
with detectors recommended by the standard (or that of
your choice).

e Pre-scan + Auto Spot - A Pre-scan followed by an
Automated re-measurement for a chosen number of spots.

e Complete Scan - A Complete scan with detectors
recommended by the standard - could be time consuming
if detectors such as CISPR Quasi Peak or CISPR Avg are

chosen.

A Spot is a signal peak that exceeds both the Threshold

and Excursion settings in the Ranges and Limits table. The
Threshold and Excursion settings are specific to the selected
range. If you want to use different settings for Spots in different
ranges, you must set the values separately for each range. The
Excursion control is used to avoid interpreting a single spot as
multiple narrower spots by requiring the amplitude to drop by
the Excursion amount between spots. Raising the Threshold
value means that fewer, larger signals will be identified as
spots.

The mapping of limit lines to the detectors is also shown under
Scan Definition and Spot measurement. This tells you which
detector will be used for Scan and Spot measurements and
which limit line will the Scan or Spot results be compared
against.

NOTE - Estimated Analysis Time is shown to give an idea of
how much time the Scan is expected to take for the detectors
chosen. This Estimated time is based out of the choice of
detectors and the span of the actual scan measurement and
is calculated under ideal conditions for a machine with 16 GB
RAM. Actual time taken for measurement could vary.

This estimated analysis time could be higher if detectors such
as CISPR Quasi Peak are used for a larger span range.
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APPLICATION NOTE

Measurement Methods
@ Pre-scan + Manual Spot (on failures)
O Ppre-scan + Auto Spot (on failures)

O Complete Scan

Scan Definition

CISPR +Pk compared with Limit2

Estimated Analysis Time: 1s

Spot measurement (only on failures)
CISPR QPk compared with Limitl

CISPR Avg compared with Limit2

l Edit Scan & Spot Setup J

Measurement Methods
O Pre-scan + Manual Spot (on faiures)
® Pre-scan + Auto Spot (on failures)

O Complete Scan

Scan Definition

CISPR +Pk compared with Limit2

Estimated Analysis Time: 1s

Spot measurement (only on failures)
CISPR QPk compared with Limitl

CISPR Avg compared with Limit2

Max Spots: 2 O A

Edit Scan & Spot Setup

Measurement Methods
O Pre-scan + Manual Spot (on failures)
O Pre-scan + Auto Spot (on failures)

@® Complete Scan

Scan Definttion
CISPR QPk compared with Limitl

CISPR Avg compared with Limit2

Estimated Analysis Time: 6s

[ Edit Scan & Spot Setup ]

FIGURE 12. Snapshots of how the scan definition and spot measurement for the different Measurement methods.

Note — The three measurement methods might not be shown
for some standards if they don’t recommend detectors such as
CISPR Quasi Peak (for e.g. Mil/Gov 461G and DEF STAN). This
is because the scan itself is done with CISPR Peak detector
which can be done faster and there is no need for a Pre-scan
followed by spot measurements in such a case.
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EMC Project Setup Wizard
Emission Type: ® Conducted O Radated
Getting Started || Accessories | Ranges & Limits | Reports
US - MIL-STD 461G - CE101-1, Submarine, DC, Greater Than or Equal to 185 A (dBuA) Edr Label
Umit 1 60
Unmit 1Margin g |
i
rE B
.
" S
jn: |
— 10
s5d Scale 0L T - - + - -
Edit Ranges & (o 0 0001 0002 0003 0004 0005 0006 0007 0008 0009 001
mits. [o]™ Frequency (MHz)
Scan Defnition
MIL +Peak compared with Limit1
Estimated Analyss Time: 1s
Edi Scan & Spot Setup
[ Ranges & Limits Help I [ Save Project Setup ” Recal Project Setup I

FIGURE 13. Example of ranges and limits shown per MIL-STD461G-CE101-1.
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EDIT SCAN AND SPOT MEASUREMENT SETUP

Edit Scan and Spot Setup allows you to modify any detector

choice or dwell time. You can also do the limit mapping

appropriately.

e Choose the appropriate detector for scan and spot re-
measurement

e Set dwell time

e Choose the limit line mapping

Scan Setup Spot Measurement Setup (only on faiures)

CISPR +Pk compared with | Limit2 CISPR QPk compared wkth | Limt1

(m] compared with CISPR Avg compared wkh | Lim&2

Owell Time: | 10 ms [ Auto (m] compared with

Estimated Analyss Time: 1s Dwell Time: | 0.00s Auto

FIGURE 14. Scan and Spot setup menu.

By default, the standard recommended limit line is mapped to
appropriate detectors.

MEASURE AMBIENT

Ambient scan is useful for capturing emissions caused by

environment or the Spectrum analyzer equipment. Before

an Ambient scan is done, the EUT must be switched off/or
completely removed from the setup.

An Ambient scan analysis is done to quickly check if the Spots
(Emission at frequencies) obtained are due to Ambient or the
actual equipment.

e Click Setup > EMC > Measure Ambient or click on
Measure Ambient in EMC Toolbar for an Ambient run.

¢ You will be prompted to switch off the equipment

EMC-EMI
Turn off the Equipment under Test for Ambient measurement

C

|[ Cancel ]

FIGURE 15. Prompt to turn off equipment power.

e The control settings for Ambient will be opened in case
you want to change the detector type or dwell time for the
Ambient measurement.

e The Ambient trace will be shown in the display.

APPLICATION NOTE

COMPARISON OF RESULTS

If you have done a scan with equipment under test turned

ON (referred to as Scan EUT ON below) and if the results
table is populated with Spots (frequencies that have failed the
threshold or limit line), then Comparison of results of Ambient
and Scan EUT ON can be done.

e The Comparison of results is done only at all failing
frequencies and Delta difference between the both are
shown.

e The comparison of results is done only if the detector type
for the Scan EUT ON and Ambient match.

Emission Results

Scan CISPR +Pk Ambient CISPR +Pk

Enable |Spur # |Range |Freq (Hz)

Ampl Delta(Limit1) Ampl Delta(Scan)
O c 50.010 MHz  [PRCRLNGN 16.09 dBuv FEM 0.51 dBuv
O c 53.010 MHz 8.14dBuV  23.70 dBuV 34.16 dBuV
O c 35.975 MHz -12.76 dBuV 0.58 dBuv

FIGURE 16. Spot results of Ambient and Scan EUT ON can be compared.

e This Delta difference is compared against a Delta threshold
setting in the Ambient Settings Control tab.

e When the absolute difference between the Scan EUT ON
and Ambient is less than this threshold, those frequency
rows in Results table are shown colored to indicate that
these emission frequencies could be due to Ambient and

not because of the equipment under test.

The Measure Ambient button in the EMC toolbar will not
be active if no instrument is connected or if no playback is
selected.

Note: For more in-depth information, refer Ambient tab of
control panel settings.

RE-MEASURE SPOT

Spot re-measurement is performed on the selected spot
(frequencies that have failed Threshold/Limit lines) from the
Emission Results table with detectors recommended by the
standard or detectors defined by you. These detectors could
typically be detectors that require larger measurement/dwell
time like CISPR Quasi peak.
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The Re-measure Spot is very useful when the user wants to do
a quick pre-scan with Peak detectors and then apply detectors
with larger dwell time only on those frequencies that have
failed the Threshold or Limit line settings. The Re-measure
Spot is useful when Measurement method is Pre-scan +
Manual Spot or Pre-scan + Auto Spot.

e Once the scan is done for the trace, failing frequencies are
listed in the Emission Results table and you can choose the
spot(s) which should be re-measured.

¢ You can choose the Spot(s) for performing Spot
Measurements either from the plot or from the Emission
Results table.

e The RBW for Spot measurement will be the same as that
used by the pre-scan. This is because it would only be
correct to compare scan and spot results when they are
done with the same RBW.

e The detector choice, limit line for comparison and dwell
time for spot measurement are based on the choices you
made while using the Setup Wizard.

e You can also change the choice of detector(s) from the
Measurement tab of the settings control panel. You can
also choose up to 3 detectors to analyze these spots.

e The Limit lines for comparison and the dwell time also can
be edited.

e (Click Setup > EMC > Re-measure Spot or click on Re-
measure Spot in EMC Toolbar to perform the Spot re-
measurement.

e The Re-measured spot results are then shown in the
Emission Results table and compared with appropriate limit
lines.

Emsssion Results

| Scan CISPR +Pk [ Spot CISPR QPk Spot CISPR Avg |
Spot ...|Spur # |Range |Freq (Hz)

i

| Ampl | Deta(limt1)|  Ampl [Deta(lmt1)| Ampl | Deka(umit)|
99.775 MHz 3.13 dBuV... QLKLY -3.42 dBu... 9.32 dBuV... -10.7 dBu...

B ¢ 560.041 MHz |SUEREIUAN 1.32 dBuV... 14.2 GBUV... -5.78 dBu... 9.30 dBuV... -10.7 dBu...
~® Bl 922.037 MHz FERICLEINAN -0.899 dB... 5.18 dBUV... -14.8 dBu... -2.13dBu.. -22.1 dBu...
4 B 945.907 MHz  14.0 dBuV... -6.01 dBu... 14.5dBuV... -5.47 dBu... 6.90 dBuV... -13.1 dBu...
0O s B 606.337 MHz  11.0 dBuV... -8.99 dBu... —dBuV/m —dBuV/m —dBuV/m - dBuV/m

FIGURE 17. Re-measured spot results are shown in the Emission Results table
and compared with appropriate limit lines.

In case the Measurement method chosen in Pre-scan + Auto
Spot, the Re-measure Spot step is automatically done for you.
The max number of spots that you wish to do an automatic
Re-measure can be set by you in the Settings control panel

— Measurement tab (under Spot measurement setup). This
control is visible only when the measurement method is Pre-
scan + Auto Spot.
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APPLICATION NOTE

The Re-measure Spot button in the EMC toolbar will not be
active in the toolbar when no device is connected or when no
playback is selected.

REPORTS

The Report wizard is used to save the test results and generate
test reports for reference.

The Report Wizard can be used to merge multiple test results
and generate the report.

To save the test Results

1. Select the Setup > EMC > Report or choose Report from
the EMC Toolbar

2. The Save Results tab would open in Results and Reports
Wizard

3. Specify a heading to the Measurement Test Results.

4. Any additional information or points related to the test can
be provided in the User Notes space.

5. Browse the image file which should be included in the
report (if any). Select the file and click OK.

6. Enable “Include Control Settings” check box to include
Control panel settings in the Report.

7. Enable “Include Graph” check box and “Include Emission
Results” check box to include plot results and emission
results in the test report.

8. Enable “Include Inspect Freq Result” to include Inspect
results in the test report. (this will be available only if Inspect
measurement is chosen)

9. Click Save. Save will be done and you will be taken to the
Generate Report tab.

PVESTINS 3

d Reports
J Save Results | Generate Report

Measurement Headng: RunHeading

ade

Time Stamp:  11-14-2017 2:17:04 PM
User Notes:  User Notes

Settings

(¥) Include Control Settings

Measurement Results
(%) Include Graph

(%) Include Emission Resukts

Incude Images:

DD D

FIGURE 18. Save measurement results menu.
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To generate the report

1.

Resuits and Reports

[Save Resuks| Generate Report |

Go to Generate Report tab in the Results and Reports
Wizard.

. Select the details which are to be included in the report by
checking the check boxes of User Information, Environment
information and EUT information. You can also the edit the
content for these sections which you might have already
set in the Setup Wizard (for User, Environment or EUT
information).

Select the saved test results among those listed in the
History List to include them in final report.

Use Generate Report button to view a preview of the final
report.

Generated report can be exported in the preferred format
(pdf, rtf and xIsx etc.) and saved locally for future use.
Recommended file types are pdf and rtf.

You can also choose to email the report if you have an
internet connection.

History

Information to include: ‘ { @] l Run Headng ]Measuremeﬁl Tme [
(] User information » D RunHeading  11/7/2017 11:55:54 ... [ )@ (@)
(<) Environment nformation [m] scan 8/9/2017 4:32:06 P [ 2@ (@]
(%) EUT nformation D Spot Resuks a... 8/9/2017 4:32:09PM [ £2J(@ ][ @]

Edk D ot with ambL.. 8/9/2017 4:32:05PM ()@ @)

FIGURE 19. Generate measurement result report menu.

APPLICATION NOTE

Troubleshooting Tools

EMC testing with Tektronix provides you a suite of
troubleshooting tools to assist in debugging.

Troubleshooting tools include:

1. Harmonic Markers

2. Inspect (Suspect frequencies)
3. Level Target

4. Compare Traces

5

. Persistence

Additional Information on Troubleshooting Tools

HARMONIC MARKERS

Harmonic markers tool allows you to place the markers at
selected harmonic factors of a chosen fundamental frequency.
It will be helpful for you to see if certain emissions that result
out of a scan are caused due to the harmonics of a known
fundamental frequency.

Harmonic marker toolbar is used to define the fundamental
frequency and harmonic factors.

Click Setup > EMC > Harmonic Markers or click on Harmonic
Markers in EMC Toolbar to open the harmonic toolbar that will
open in the bottom above the Marker toolbar.

In the Harmonic marker toolbar, enter the Fundamental
frequency. This is the base frequency on which harmonics are
calculated.
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APPLICATION NOTE

Harmonic Markers Fundamental Freq: 1.000 GHz Harmonic Factors: MR: 1/4|v] M1: 2 v M2: 3 v M3: 4 |v M4 10 |v Apply X
FIGURE 20. Harmonic marker toolbar.
Marker Readout
Table Marker  Frequency A Frequency Time A Time Amplitude A Amplitude Phase A Phase Distance A Distance EMC-EMI A EMC-EMI
MR 0.000 Hz -5.086 ms 106.99 dBm 0.0000 © 0.000 m —
M1 0.000 Hz 0.000 Hz -5.086 ms 0.0000s 106.99dBm  0.00 dBm 0.0000 = 0.0000 ° 0.000 m 0.000 m — —
M2 0.000 Hz 0.000 Hz -5.086 ms 0.0000s 106.99dBm  0.00 dBm 0.0000 ° 0.0000° 0.000 m 0.000 m — —
M3 0.000 Hz 0.000 Hz -5.086 ms 0.0000s 106.99dBm  0.00 dBm 0.0000 = 0.0000° 0.000 m 0.000 m — —
M4 0.000 Hz 0.000 Hz -5.086 ms 0.0000s 106.99dBm  0.00 dBm 0.0000 = 0.0000° 0.000 m 0.000 m — —
FIGURE 21. Marker Readout Table.
Choose the harmonic factors from the drop down for the 5 INSPECT

markers (MR, M1, M2, M3, M4). The harmonic factors in the
drop down can be 1/8,1/4,1/2,1,2, 3,4, 5,6, 7, 8,9 or 10.

Click Apply to place the markers at the appropriate harmonics.

Clicking Apply will also open the Marker table which will give
information about the frequency at which these markers are
placed, and the amplitude values can be seen under the
respective display column (e.g. - EMC-EMI if that is the active
display)

Note: Harmonic markers can be used for other spectral
displays too (displays having Amplitude vs freq e.g. —
Spectrum, DPX etc.). Even if EMC-EMI display is not open, this
toolbar can be invoked from View> Harmonic Markers toolbar.

When the chosen harmonic factors are not in the range of the
scan results then the markers could be aligned with the left
or right edges to indicate that the chosen factors are outside
the range of the scan. (e.g. - if the stop frequency is 6.2 GHz
and if we attempt to place a marker at the 10th harmonic of a
fundamental frequency that is 1 GHz, then the marker will be
placed at 6.2 GHz itself.
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Inspect suspect frequencies is a troubleshooting tool that

can be used by you to analyze a set of suspect frequencies in
more detail. As many as 3 detectors can be selected and the
detector results will be shown in a table format for each of the
suspect frequency. The result can also be compared with a
comparison level and the entire set of results can be reported
out too.

On Selecting Inspect from EMC Toolbar or from Setup > EMC
> Inspect, the results table and the Settings Control will open.

The results table will show the Inspect results. The
measurement can be triggered by hitting Single or Continuous
which can be found at the top of results table. The results can
also be brought into the Report using the Report tool from
EMC Toolbar.

Inspect display has 2 modes of harmonics measurement.
Harmonic and Discrete
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APPLICATION NOTE

[Parameters|[Emission Type [ Accessories|[ Ranges & Limits|[ Measurement Type | Traces|[ Ambient | Inspect | Scale][Prefs]
Modes Fundamental Frequencies + Harmonic Factors Detector Setup
@® Harmonic 50.000 MHz Edit Factors [7) Detector 1 |CISPR QPk [v) Comparison Level |39.99 dBuv Dwell Time: | 1.000 s Auto
O Discrete [¥) 50.000 MHz Edit Factors [J Detector 2 Comparison Level
[ [50.000 MHz Edt Factors [ Detector3 Comparison Level

FIGURE 22. Inspect display of Harmonic measurements.

Harmonic Mode

In Harmonic mode, the suspect frequencies are built as
harmonics of fundamental frequencies.

The detectors can be chosen from the drop down in the
Detectors Setup. As many as 3 detectors can be chosen.
Comparison level can also be chosen for each detector too.
Dwell time can be controlled too.

Harmonic factors can be entered for each of the fundamental
frequency by clicking on Edit factors (see snapshots below).
Final frequency is calculated as Fundamental Frequency *
Harmonic factor. The Edit Harmonic Factors/RBW table will
allow you to edit RBW settings for the frequency that is being
analyzed. Auto RBW flag will set RBW based on the chosen
detector and frequency band in which the final frequency falls.

Edit Harmonic Factors/RBW. ]

Fundamental Frequency: 50.000 MHz
on H’a:;ncwt%r:ic Final F(r:;:)uency RBW (Hz) A:ﬁo SW
Hh Bl v+ | 1250w 9.000k v
v 1/2 25.000M 9.000k v
v 2 100.000M 120.000k v
v 3 150.000M 120.000k v
4 200.000M 120.000k v
5 250.000M 120.000k v
6 300.000M 120.000k v
7 350.000M 120.000k v
8 400.000M 120.000k v
9 450.000M 120.000k v

FIGURE 23. Harmonic factors can be entered for each of the fundamental
frequency.

On hitting Single or Continuous in the Inspect Suspect
frequencies display, the Inspect results will be shown as below
and is compared against the respective Comparison Levels.
Failures will be shown in red color.

Inspect Suspect frequencies can be done in Single (Stops
after all suspect frequencies are analyzed once) or Continuous
mode (will continue updating the results table until stopped).

Inspect Suspect Frequendies (=]
|‘-) Single i' Q canmuousl Settings l Clear
Detectorl: CISPR QPk ]
Fundame... | Harmonic Delta from
IndeX | "freq (Hz) |  Factor fa (ol [Rew/ (i) Abs 11.0
dBuV/m
50.000 MHz  1/4 12.500 MHz ~ 9.000 kHz 0 dB 5.02 dBuV...
50.000 MHz 1/2 25.000 MHz 9.000 kHz -6.70 dBu... -17.7 dBu...

2

3 50.000 MHz 2
4 50.000 MHz 3
5 35.000 MHz 1
6 35.000 MHz 2

100.000 MKz 120.000 kHz 104 dBuV... -0.575 dB...
150.000 MHz ~ 120.000 kHz 0.653 dBu...
35.000 MHz  120.000 kHz 10.1 dBuV... -0.927 dB...
70.000 MHz 120000 kHz  10.2 dBuV... -0.836 dB...

FIGURE 24. Inspect Suspect frequencies can be done in Single or Continuous
mode.
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APPLICATION NOTE

EMCSettings  [paameters|[ Emisson Type][Accessories|[ Ranges & Limks|| Measurement Type [ Traces|[ Ambient]| Inspect [ Scale|[Prefs
Modes Discrete Table Detector Setup
O Harmonic Detector 1 | CISPR QPk (¥) comparison Level |11.0dBuv/m | Dwel Tme: [100 ms [J Auto
Edit Frequencies =
® Discrete [ petector 2 Comparison Level |+
[J petector 3 | + Comparison Level

Restore ]
Defaults

FIGURE 25. Discrete mode displays a list of suspect frequencies.

Discrete Mode

1. In Discrete mode, you can develop a list of suspect
frequencies by clicking on Edit Frequencies.

2. The detectors can be chosen from the drop down in the
Detectors Setup. As many as 3 detectors can be chosen.
Comparison level can also be chosen for each detector.

3. Suspect frequencies can be entered by clicking on Edit
Frequencies button.

4. The suspect list can also be loaded from “Load from
Emission results” which will load the top 15 spots recorded
in the Emission Results table at the result of a scan.

Edit Frequencies/ RBW m
Load From Emission results

On Frequency (Hz) RBW (Hz) A:'io $
v 18.004M 9.000k v
v 11.829M 9.000k v
v 45.696M 120.000k v
v 63.912M 120.000k v
82.176M 120.000k v
100.440M 120.000k v
118.775M 120.000k v
70.990M 120.000k v
27.409M 9.000k v
86.997M 120.000k v
137.039M 120.000k v
129.415M 120.000k v
131.006M 120.000k v
131.719M 120.000k v
» Tl 10.010m 120.000k v

FIGURE 26. The suspect list can be loaded from “Load from Emission results”.
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5. If no spots are listed in the Emission Results table, the
following warning message is shown when “Load from
Emission results” is hit.

Information

FIGURE 27. Warning message if no spots are listed in the Emission Results table.

6. On hitting Single or Continuous in the Inspect Suspect
frequencies display, the Inspect results in Discrete mode
will be shown as below. The results are then compared
against the respective Comparison Levels and failures will
be shown in red color.

Inspect Suspect Frequencies [=][x]
Il-b Snulei| IQ Continuous I Settings
Detectorl: CISPR QPk Detector2: Avg (VRMS) Detector3: +Peak ]
boex | FeaGw |RWOm | PRET | PRET e | TR0
dBuV/m dBuv/m dBuv/m

10.689 MHz  9.000 khz 9.13 dBuV... 20.7 dBuV... -19.3Bu... 31.0 dBuV... -9.00 dBu...
45.625MHz  120.000 kHz 3.62 dBUV... 12.2dBuV... -27.8 Bu.. 21.2 dBuV... -18.7 dBu...
63.912 MHz  120.000 kHz [FERCREINMN 3.37 dBuV... 12.3dBuV... -27.7 dBu... 22.2dBuV... -17.7 dBu...
B 52.010MHz  120.000 kHz [FEJERIAN 6.32 dBuV... 14.3 dBuV... -25.7 dBu... 23.7 dBuV... -16.3 dBu...

FIGURE 27. Inspect results in Discrete mode are compared against the
respective Comparison Levels.

In Inspect suspect frequencies display, all detector
results are held on between acquisitions unlike the scan
results which is computed afresh every scan. When Clear
button is hit, all detectors results will be cleared. This will
allow you to set a smaller dwell time even for detectors
such as CISPR Quasi Peak and build stable results over
acquisitions resulting in faster analysis/updating.

Note: For more in-depth information, refer Inspect section of
Control Panel settings.
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FIGURE 28. Use Level Target to assign it to the peak of a scan and retain the level for comparison for the next scan.

LEVEL TARGET

Level target is an indicator on the display that can be set by
you. You can move it with a mouse. It can also be set at the
Peak of the active waveform. This tool is available on four
displays (EMC-EMI, Spectrum, DPX and Spurious). The Level
Target will change in other displays too when changed in the
active display.

You can use Level Target to assign it to the peak of a scan and
retain the level for comparison for the next scan and see how it
compares with the new scan results.

. Click Setup > EMC > Level Target or click on Level Target

in EMC Toolbar.

This will open Spectrum if it is not open already and place
the Level Target in the display. If Spectrum is already open,
then hitting Level Target toggles visibility of Level Target.

. Clicking on "To Peak" in the vertical control of the display

or the Prefs Control Panel moves the Level target to peak of
the trace.

. Level Target indicator can be shown or hidden in the display

by enabling or disabling the checkbox “Show Level Target”
in the Prefs Control Panel settings.
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COMPARE TRACES

This troubleshooting tool can be used to compare any traces.
This tool can be used to compare as many as 2 live scan
traces, 3 spot traces, 5 recalled traces and a Math Trace

APPLICATION NOTE

The scan and spot results are saved in the form of trace. Each
result is saved in a different trace.

This trace tab gives the information of the list of Live Traces
saved, Recalled trace and Math Trace.

(which is the result of subtracting any two traces). Legends for

these traces will be shown in the graph too.

EMC Settings

Live Traces:

Parameters|[ Emission Type |[ Accessories [ Ranges & Limits|[ Measurement Type || Traces [ Ambient|[ Scale|[ Prefs

Recalled Traces: Math Trace:

Restore
Defaults

[ [selected | show | Trace Name | Function [ Count] e Selefted Show | Trace Name Trace File Path [ show O Freeze (e
G =] Scani CISPR +Pk Normal 1 for Compare O Recalll A
O Spot1 CISPR QPk o) [0 Recl2 L=l Scant minus | Scanl @] [0 Show recalled trace
O Spot2 CISPR Av Save Selected o) 0 Real3 |
> o Trace As e e = (-]

FIGURE 29. Compare Traces menu.

SETTINGS DESCRIPTION

Live Traces

Trace results of the last measurement that was done through Scan or Re-measure Spot.

Selected | Specifies the trace selected in the list. This also serves the purpose of making a trace active (Active trace is also selected from
the top of the graph). Active trace selection puts the trace on the top of other graphs. This is useful when there are multiple
traces viewed together.

Show | Shows / hides the selected trace.

Trace Name | Specifies the name of the trace. For Live Traces, these names are set by appending Detector choice with the measurement (Scan
vs Spot based on whether scan is done or Re-measure Spot is done). The number after Scan or Spot is based on the number of
detectors chosen for Scan and Re-measure spot measurements in Measurement tab.

Function | Specifies the function performed on the trace. Applicable only for scan trace in Live Traces.

Count | Specifies the count value for Function when Function is not Normal (Max Hold, Average etc.). When Function is Normal, this

control is not editable as the Count is 1.

Quick Save for Compare

When this button is pressed, the selected Live Trace is saved automatically in your drive and recalled into one of the rows in
Recalled Traces depending on which one is free. The search is done from Recall1 through Recall 5 in that order. There will be a
timed pop message indicating the Recall Trace in which it is available for comparison.

If none of the Recalled Traces are free, then clicking on “Quick Save for Compare” will save the trace in your drive and recall
the trace as Recall 1 (replace the earlier recalled trace in Recall 1). However, the files replaced can be browsed for and recalled
using “Recall to Selected Trace”. All traces saved with “Quick Save for Compare” are saved in SignalVu-PC Files directory

Save Selected
Trace As

Saves the Selected trace to a file for Recall and later analysis. This button is active only when a Live Trace is selected and only
the selected trace is Saved.

Recalled Traces

Selected

Specifies the trace selected (This will also make the Recalled Trace active and bring it to the top of all displays). Emission Results
table will be populated with Spots based on the comparison of selected Recalled trace with Limit 1.

Show

Shows / hides the selected trace.

Trace Name

Specifies the name of the trace which was saved.

Trace File Path

Specifies the path of the saved trace file to be recalled.

Recall to Selected Trace

Recalls the trace for analysis into the Selected Recalled Traces row.

Math Trace

Show

Shows / hides the Math trace.

Freeze

Freeze the Math trace.

Save Trace As

Saves the trace to a file for recall and future Analysis.

Show Recalled Trace

Displays a saved trace instead of a live trace.

Trace Selections for Math

Choose trace for difference operation from two drop downs. Trace 1- Trace 2 is done at every trace point.
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Scan CISPR +Pk Recal Trace

FIGURE 30. Emission Results table.

Saving Traces

To save a trace for later analysis:

1. Select a Live Trace

2. Select the Save Selected Trace As button. This displays the
Save As dialog box.

3. Navigate to the desired folder or use the default.

4. Type a name for the saved trace and click Save.

il n.m‘““‘:uhiﬁ“wnmmllAm u“ﬂt‘] h:l.w&u.ﬂ ‘JLMMHM“ ad Imhlv-l; xumm.un; ﬂ .|Idnluld:

Recalling Traces

You can recall a previously saved trace for analysis or
comparison to a live trace.

To select a trace for recall:
1. Select a Recalled Traces row into which you want to
recall a trace.

2. Select the Recall to Selected Trace button. This displays
the Open dialog box.

3. Navigate to the desired folder or use the default.
4. Select the appropriate trace to be opened and click Open.

5. Recalled Trace will be plotted on the graph and comparison
with Limit1 will be done and results will be shown in the
Emission Results table
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FIGURE 31. The Math trace is a mathematically-derived trace defined as Difference between two traces.

Math Trace

The Math trace is a mathematically-derived trace defined as
Difference between two traces. You can select the two traces
for difference calculation among the Live Traces, Recalled
Trace and the Ambient Trace.

1. Select any of the trace from the list of traces provided in
drop down (Trace1 and Trace2)

2. Traces can either be Live Scan Traces, any of the 5
Recalled trace or Ambient trace.

3. Difference between the two traces can be derived from the
operation Trace1 minus Trace 2.

4. The resulting trace can be shown on the graph region by
using Show checkbox and can be frozen using the Freeze
checkbox.

5. The resulting trace can be saved into a file using Save Trace
As button.
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. The saved trace can be recalled for the analysis by

navigating to the desired folder. When a trace is recalled
under Math, controls such as Show, Freeze and selections
of traces for Math will be disabled.

. The Math functionality is done for each range in the Ranges

& Limits settings control.

. If the span or trace points for any range doesn’t match,

then an error message will be put up for Math traces. e.g.
“No Math trace: Unmatched trace X range”

“No Math trace: Unmatched trace lengths”

. The Math trace is done only for log units in Y axis and the

difference trace is calculated by mere subtraction of the dB
values.
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APPLICATION NOTE
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FIGURE 32. The DPX™ spectrum display, unique to Tektronix RTSAs, ensures that any signal lasting longer than a few 10s of microseconds is instantaneously captured

and displayed.

PERSISTENCE DISPLAY

This troubleshooting tool launches the DPX display which
has the capability to show persistent view over multiple
acquisitions. DPX is fast and lets you pick even transient
emission.

The DPX™ spectrum display, unique to Tektronix RTSAs,
processes more than 10,000 spectrum measurements per
second (exact number depends on which instrument in
the portfolio is chosen), and ensures that any signal lasting
longer than a few 10s of microseconds is instantaneously
captured and displayed. More information on the operation
of the DPX spectrum processor in RTSAs can be found in
application note 37W-19638. The color grading seen in the

display indicates frequency of occurrence of the signal. More
frequently occurring signals are presented in red and infrequent
signals in blue to green. With a potential problem discovered
by DPX, the next step is to trigger on and capture the signal
for further analysis. This is easily accomplished by defining a
frequency mask trigger based on the continuous signal profile,
and capturing the infrequently occurring transient when it
appears in the spectrum. Any signal above the frequency mask
threshold lasting longer than the specified minimum signal
duration will cause a trigger and store the pre-trigger and post-
trigger signal into memory.

Click Setup > EMC > Persistence Display or click on
Persistence Display in EMC Toolbar to open DPX.
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NEAR FIELD TOOLS FOR DEBUGGING

The far field test can accurately tell whether the product
passes or fails but cannot pinpoint the source of a problem.
Using only the far-field test, one cannot isolate problems down
to specific components or locations, like too much RF energy
“leaking “from an opening in a metal enclosure or help identify
a cable radiating too much RF energy. The near-field test is

a good way to locate such emission sources and is typically
performed using a spectrum analyzer and near-field probe.

Near-field Probes for EMI are electromagnetic pickups used

to capture either the electric (E) or magnetic (H) field at the
area of interest and are used with the spectrum analyzer. We
provide a kit of probes (EMI-NF-PROBE) that offer the best
compromise between size, sensitivity and frequency range,
and you may need all the sizes in your toolkit to solve your
problem. Selection between an H-field or E-field probe may be
driven by location of a signal in your design, or by the nature
of its source (voltage or current). For example, the presence of
a metal shield may suppress the E-field, making it necessary
to use an H-field probe for the application. Near-field probes
must be used to either pick up the signal near the device under
test. For further information Tektronix has an application note
that focuses on troubleshooting EMI problems using near field
probes." We also offer an amplifier for the near field probe to
increase the measurement reading EMI-NF-AMP- to be used
mostly with the E-Field.

APPLICATION NOTE

FIGURE 33. A near field probe can be used to discover the location of
unintended RF emissions.

Conclusion

Failing an EMI compliance test is expensive and can put a
product development schedule at risk. However, setting up
your own pre-compliance testing can help you isolate any
problem areas and fix them before you go to the complaint test
house. Tektronix offers a low cost pre-compliance capability
that will help you minimize both your expense and schedule in
getting your products EMI certified.

' “Practical EMI Troubleshooting”, http://www.tek.com/document/application-overview/troubleshooting-emi-problems
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Appendix

APPLICATION NOTE

Setting Ranges & Limits

Use the Ranges and Limits tab to specify the parameters that control the EMC-EMI measurement. From the Ranges and Limits

tab, you can specify the start and stop frequencies for ranges, the parameters that define a Spot (for listing in the Emission Results

table) and Pass/Fail parameters for Limit testing.

[ Parameters|| Emission Type || Accessories | Ranges & Limits | Measurement Type | Traces|[ Ambient | Scale][ Prefs|
Ut mitt . Um2 | Umt )
On Start() Stop(h) REW(H) Aubo %’ o Eﬂ; E)(‘;’B*;" St Swp Lo sat  Stp oo [@umt2 | EdtLimt Label
(@) (@) @) (@)
v & [Elseon... [Loo0os [1zo00 [ V | w0 60 |00 leo0 | v [m000 |m00 | ¥ Ouimk 3 fesetvout
B 500.0000... |5.00000M | 5000k | v | 500 (60 (12500 (12500 | v (1500|1500 | ¥ .
Margin: |6 dB Load
¢ 5.000000M | 30.000000M | 5000k | V| &0 60 (1500 (1500 | ¥ (w500 |10500 | ¥
D | [0000000 0000000 (200000 | v M %59 60 (%693 %99 699 %69 o| [ leadFomstngad | [ sae |
o ovocos Tooreros Tovnoss 17 Ty P N P Y Py

FIGURE 34. Ranges and Limits menu.

SETTING DESCRIPTION

Expand

You can edit the Ranges and Limits table in two ways:

Displays the Ranges & Limits Table in a new, °
resizable window.

Edit values directly from the Ranges and Limits tab. You
may have to scroll the table to access all settings when

Reset layout

You can reorder columns in the Ranges and multiple ranges are selected.
Limits Table by dragging the columns to a new
position. Clicking Reset Layout returns the

column order to the factory default order.

e (Click the Expand button. This displays the Ranges and
Limits Table in a new window that can be sized to the full

- — screen.
Load Click to load a saved Ranges and Limits table
from afile.
. o BE
Save Click to save the current Ranges and Limits ————
table to a file. o sl | vak) i) sa BT A T el s X e s
. . . . LY -l Ll T 'J--ID»B. a - AL ‘e “x “x - wom:
Limit 2 Enable to set and Limit 2. ol [ e ] . ol S el s
P . T | o) axxw | M ®4 0 mE  mE
Limit 3 Enable to set and Limit 3. 2 [ Tames fixme = - (T
LE@ iape - e e el AN
Margin Click to set the Margin value. D1 e e w | s e me omw
. . 1oL axoxy [axxw | I KAd_CC_ ol an
Load from Standard Click to load a Ranges & Limits table as . o e L
defined by a Standard. N :;;;;‘ { & T —
. . . . - A ARURY  AAEE - “ae (13 - -t
Edit Limit Label Click to edit the Limit label. o [Thimma liase ™ waehe am e avl |
- T 1wen ‘- ] e L .
? 2300000 |3 300 ~ %2 ec  wmy my S |
2 R S TR Y - “ae e o i
e e X F:‘? S v [ om ]

FIGURE 35. Edit values directly from the Ranges and Limits tab.
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APPLICATION NOTE

The following table describes the parameters that are set in the Ranges and Limits Table.

RANGES AND LIMITS TABLE SETTINGS

SETTING | DESCRIPTION

On Specifies whether the measurements are taken in the specified range or not.

Start (Hz) Readout of the start frequency for the selected range.

Stop (Hz) Readout of the stop frequency for the selected range.

RBW (Hz) Specifies the Resolution bandwidth used for the selected range.

Auto Sets the RBW automatically. For CISPR standards, frequency range decide the RBW.

VBW (Hz) Adjusts the VBW (Video Bandwidth) value. VBW Maximum: RBW current value; VBW Minimum: 1/10,000 RBW setting.

VBW On Specifies whether the VBW filter is applied.

Thrshid Threshold specifies the level that must be exceeded for a signal peak to be recognized as a Spot. A signal peak must also exceed

(dBuV or dBuV/m) the Excursion setting to be considered a Spot.

Excrsn (dB) Excursion specifies the peak to peak magnitude that must be exceeded for a signal peak to be recognized as a spot. A signal
transition must also exceed the Threshold setting to be considered a Spot. A Spot requires the amplitude to drop by the Excursion
amount between spots.

Limit 1/2/3 Start Specifies the Limit at the start frequency.

(dBuV or dBuV/m)

Limit 1/2/3 Stop (dBuV) | Specifies the Limit at the stop frequency. The limit values for the frequency range is calculated by linear interpolating between

(dBuV or dBuV/m) Limit Start and Limit Stop. The frequency start and stop values are taken in Linear or Log based on the scale choice.

Limit 1/2/3 Same Enables to set the starting and stopping limit as same.

Limit 2 Enable to set and display limit 2.

Limit 3 Enable to set and display limit 3.

Margin Click to set the Margin value. (Applied to all limits)

Reset layout You can reorder columns in the Ranges and Limits Table by dragging the columns to a new position. Clicking Reset Layout returns
the column order to the factory default order.

Save Click to save the current Ranges and Limits table to a file.

Load Click to load a saved Ranges and Limits table from a file.

Done Save changes and close the Ranges and Limits Table window.

LOADING FROM STANDARD

To Load:

1.

28

Click the Load From Standard button on the Range and
Limits tab.

. Select the required region form the drop-down provided.

Select the required standard form the drop-down provided.

(The version of the standard from which limit lines tables
are listed is shown). You will need to procure the standard
for knowing the test setup and other details.

Select the required Limit Table based on the EUT to be
tested form the drop-down provided.

Click OK to load the Ranges/Limits in this tab and the

detector choices/Limit line mapping in the Measurement tab.

I WWW.TEK.COM

Load From Standard

Standard: EN55011 @] EN 55011:2016

Limit Table ©

(Equipment): Table 6, Class A, Group 1, Less Than or Equal To 20kVA (10m)
o]

FIGURE 36. Use the Load From Standard button to set the Range and Limits per
the standard.
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CHANGING THE RANGE START AND STOP FREQUENCIES

To change the range start and stop frequencies, edit the Start
and Stop frequencies in the Ranges and Limits Table:

1. Click the Expand button on the Settings > Range and
Limits tab. This displays the Ranges and Limits Table.

2. Click the On box for a range to take measurements in the
range.

3. Click on the Start or Stop frequency setting to change
it. Type in a number for the frequency and a letter as a
multiplier. You can use k, m, or g to set the frequency
multiplier.

4. Click Done to save your changes.
SPECIFYING SPOT REQUIREMENTS

A Spot is a signal peak that exceeds both the Threshold

and Excursion settings in the Ranges and Limits table. The
Threshold and Excursion settings are specific to the selected
range. If you want to use different settings for Spots in different
ranges, you must set the values separately for each range. The
Excursion control is used to avoid interpreting a single spot as
multiple narrower spots by requiring the amplitude to drop by
the Excursion amount between spots. Raising the Threshold
value means that fewer, larger signals will be identified as
spots.

To specify the Spot requirements for a range:

1. Click the Expand button on the Range and Limits tab. This
displays the Ranges and Limits Table.

2. Select the Range (A-T) for which you want to specify the
Spot requirements.

3. Set the Thrshld value.

4. Set the Excrsn value.

Note: Spot specification is also dependent on the “List Spots”
selection in the Parameters tab. By default, this selection is All
Spots, in which case, all frequency peaks above the Thrshid
(subject to Excrsn violation) are classified as Spots for listing in
the Emission Results table. If this selection is Over Limit, then
only those frequency peaks above the limit line classify as a
Spot for listing in the Emission results table. The third selection
is “Over Limit with Margin” which will only classify frequency
peak that violate Limit line with Margin included in them.

APPLICATION NOTE

SETTING LIMITS

Use the Limits settings in the Ranges and Limits Table

to specify the pass/fail parameters for the EMC-EMI
measurement. When the Mask setting is set to any value
except off, the instrument identifies any signal peak that
exceeds the specified limits as a violation and displays Fail on
the screen. If no signal peak exceeds the limits, the instrument
displays Pass on the screen. The Margin control lets you set
the elbow room that you would want around the Limit line. The
frequency peaks that violate the limit lines are shown in red
color both in the graph and Emission results sections. If they
violate only the limit line, then they are shown in Orange color.

PERFORMING PASS/FAIL LIMIT TESTING

To set limits:
1. Click the Expand button on the Range and Limits tab. This
displays the Ranges and Limits Table.

2. Adjust the Start and Stop frequencies as required for each
range you want to test.

3. For ranges that you wish to test, verify that the On box is
checked.

4. Set the limits as desired in the Start, Stop.
5. Set the required RBW and VBW.

6. Verify that the Thrshid and Excrsn values are set as
required. These are the values that define a Spot.

7. Click Done to save your changes and close the Range and
Limits Table window.

8. Click Run to begin testing.

Note: All above parameters can be set either manually, or can
be loaded from a file or from a specified Standard.
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ACCESSORIES EMI-BICON-ANT has the following characteristics

(Antenna factor)
Tektronix offers fully validated accessories including antennas,

Line Impedance Stabilization Networks and pre-amplifiers 0

individually, or in two comprehensive accessory bundles for [““'“ stength  Measured Voltage - Antenna ‘«"'°’]

= N [9B(m )]
conducted and radiated tests. These accessories are validated % o 1 meter
by Tektronix with characterization of accessories, including s -
Gains and Losses values, pre-loaded into EMCVu to provide “z o ometen
simple set-up and greater accuracy in your measurements. g
ANTENNAS ° o 50 100 150 200 250 300
EMI-BICON-ANT Frequency (MHz)
The EMI-BICON-ANT is a broadband, linearly polarized FIGURE 38. EMI-BICON-ANT antenna factor.
Biconical Dipole Antenna with collapsible elements, operating
over the frequency range of 25 MHz to 300 MHz. Each full-
size biconical element (54 cm cage diameter) collapses to a These factors can be loaded into the Accessories tab of the
maximum diameter of 5 cm for easy transport/storage. Settings control panel or through the Setup Wizard of the

EMCVu software. The file will be available to you when you
install the software in C:\SignvalVu-PCFiles\EMC_Accessories

EMI-CLP-ANT

The EMI-CLP-ANT is a broadband, linearly polarized Log
Periodic Dipole Array (LPDA) Antenna, operating over the
frequency range of 200 MHz to 1 GHz; and with excellent
efficiency between 300 MHz and 1 GHz.

The EMI-CLP-ANT Compact Log Periodic Antenna is intended
for use as an EMI test antenna for qualification-level regulatory
compliance measurements (FCC, CE, RTCA DO-160, FDA,
SAE Automotive, etc.).

FIGURE 37. EMI-BICON-ANT Biconical Antenna.

The EMI-BICON-ANT Biconical Antenna is intended for

use as an EMI test antenna for qualification-level regulatory
compliance measurements (FCC, CE, Mil-Std, RTCA DO-160,
FDA, SAE Automotive, etc.).

FIGURE 39. EMI-CLP-ANT Log Periodic Dipole Array (LPDA) Antenna.
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The EMI-CLP-ANT can also be mounted using the EMI-
TRIPOD tripod (which is a part of the accessories given by
Tektronix)

50 15
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FIGURE 40. EMI-CLP-ANT antenna factor.

EMI-TRIPOD

The recommended support structures for the EMI-BICON-
ANT is the EMI-TRIPOD Antenna Tripod. One of the standard
accessories is the EMI-TRIPOD Antenna Pipe Holder, which
clamps securely around the one-inch diameter feed tube of the
EMI-BICON-ANT. It is then secured to a tripod or mast via its
1/4” x 20 thread mounting hole.

FIGURE 41. EMI-TRIPOD Antenna Tripod.

APPLICATION NOTE

PREAMPLIFIER

EMI-PREAMP

The EMI-PREAMP is a broadband, high gain, low-noise
preamplifier operating over the frequency range of 1 MHz to 1
GHz. Its high gain (33 dB +3 dB) and low noise figure (<3.3 dB)
make the preamplifier the ideal choice for optimizing your EMI
measurement system, whether it be a test chamber, open area
test site or tem-cell.

The EMI-PREAMP can be powered by its internal, rechargeable
battery packs, or by its AC to DC Power Adapter/Battery
Charger. On a full charge, the preamp will operate on battery
power for over 13 hours. The battery low indicator light will

let you know when it is time to plug it in; and the charging
indicator light will let you know that its charging. If you are
unable to plug it in, you can feel confident in continuing your
test, as the EMI-PREAMP will turn itself off well before the
battery voltage reaches the point at which the gain could
become unstable. Whether it’s operating on battery power or
external power; if the amp is on, you can rest assured that the
output is stable and that the gain will remain constant.

v
onns A

FIGURE 42. EMI-CLP-ANT broadband, high gain, low-noise preamplifier.

Nearly all measurement systems for radiated EMI tests require
preamplification to achieve the necessary sensitivity.
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FIGURE 43. EMI-CLP-ANT gain.
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TBLCO08 50uH AC-LISN - TEKBOX

The TBLCO8 is a Line Impedance Stabilization Network for the
measurement of line-conducted interference within the range
of 9kHz to 30MHz, as per the CISPR16 standard. The device is
designed for testing single phase, AC-powered equipment with
supply voltages up to maximum 260 V. Conducted noise can
be measured on the phase and on the neutral conductor. The
TBLCO08 is equipped with a switchable limiter/attenuator.

The LISN provides for stabilization and lets you measure what
amount of energy is fed back to the power line. The LISN is
powered and the front-end power socket lets you power your
equipment under test (EUT). The emissions that is fed back to
the power line is available at RF out for a receiver or spectrum
analyzer to measure.

The LISN is connected to the AC power supply and provides
power to the EUT. The spectrum analyzer is connected to the
RF out of the LISN. TBLCO08 has an inbuilt limiter which can be
switched ON to avoid transients. The emission that are usually
fed back to the power line is made available at RF out by the
stabilization network.
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FIGURE 44. TBLCO08 Line Impedance Stabilization Network (LISN).
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Find more valuable resources at TEK.COM

Contact Information:

Australia* 1 800 709 465

Austria 00800 2255 4835

Balkans, Israel, South Africa and other ISE Countries +41 52 675 3777
Belgium* 00800 2255 4835

Brazil +55 (11) 3759 7627

Canada 1 800 833 9200

Central East Europe / Baltics +41 52 675 3777
Central Europe / Greece +41 52 675 3777
Denmark +45 80 88 1401

Finland +41 52 675 3777

France* 00800 2255 4835

Germany* 00800 2255 4835

Hong Kong 400 820 5835

India 000 800 650 1835

Indonesia 007 803 601 5249

Italy 00800 2255 4835

Japan 81 (3) 6714 3010

Luxembourg +41 52 675 3777

Malaysia 1 800 22 55835

Mexico, Central/South America and Caribbean 52 (55) 56 04 50 90
Middle East, Asia, and North Africa +41 52 675 3777
The Netherlands* 00800 2255 4835

New Zealand 0800 800 238

Norway 800 16098

People’s Republic of China 400 820 5835
Philippines 1 800 1601 0077

Poland +41 52 675 3777

Portugal 80 08 12370

Republic of Korea +82 2 6917 5000

Russia / CIS +7 (495) 6647564

Singapore 800 6011 473

South Africa +41 52 675 3777

Spain* 00800 2255 4835

Sweden* 00800 2255 4835

Switzerland* 00800 2255 4835

Taiwan 886 (2) 2656 6688

Thailand 1 800 011 931

United Kingdom / Ireland* 00800 2255 4835
USA 1 800 833 9200

Vietnam 12060128

* European toll-free number. If not
accessible, call: +41 52 675 3777
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